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PART 1: ON1RESIZE Al 2022 OVERVIEW

Sharpening
Film Grain

Tiling

Gallery Wrap

Resize Al 2022 is the latest version of ON1's professional-quality resizing tool. Rebuilt from the ground
up with an entirely new resizing engine, Resize Al uses state-of-the-art Al neural networks to create the
highest-quality photo enlargements of any resizing tool on the market.

Existing methods of photo enlargement make up new pixels or resolution by copying those around them,
which often leads to enlarged photos with less detail, soft edges, and more noise. Resize Al’s super-
resolution technology enlarges photos while maintaining and recovering detail and sharpness. Resize Al’s
primary features include:

o Create large prints. Resize Al excels at making stunning poster-sized prints. Easily crop to a
specific paper size, resize the photo with the ultimate detail, and then print it directly or save
the file to send to a photo lab.

e Crisp details. Resize Al upscales your photo to any size and sharpens the final details
incredibly well. You can even crop a portion of your photo and still have amazing quality and
detail. It can equate to having a longer lens without the expense or weight.

¢ Breathe new life into old photos. With older digital photos, size and quality do not compare
to what is available today. ON1 Resize Al lets you remaster old images, making them bigger,
sharper, and cleaner than ever before.

¢ Reduce JPG artifacts. Whether you have over-compressed or photos that are small in size,
Resize Al can reduce the compression artifacts while creating new details, leading to higher
quality images with increased resolution.

¢ Gallery Wraps. Resize Al’s gallery wrap feature can add reflected or stretched wings to the
edge of your photo so you can make a canvas gallery wrap without losing image area.
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¢ Tiling. Divide the photo into tiles or strips to make it easier to print a mural. You control the
size of the tiles and how much they overlap for trimming.

e Batch processing and export. The powerful batch-processing engine in Resize Al lets you
enlarge a group of photos all at once, while the full-featured export function lets you control
how they are named, where they are saved, their file type, and much more. You can even add
custom graphic- or text-based watermarks to your exported photos.

e Print presets for easy automation. When it comes to preparing photos for print, knowing
the proper resolution for your printer and the correct amount of sharpening for your paper
choice can be daunting. Resize Al’s built-in presets make this a breeze. Just pick the kind of
printer, the type of paper, and the size.

e Complete printing support. By incorporating the full print engine from ON1 Photo RAW,
Resize Al lets you print directly from the app, whether used in standalone mode, or as a
plug-in. You can even use Resize's soft proofing feature to see how your photo will look when
printed using specific printer and paper profiles.

¢ Powerful workflow integration. Resize Al works either as a standalone application, or as a
plugin for Capture One or Adobe’s Lightroom Classic, Photoshop, and Photoshop Elements.
Lightroom Classic and Capture One also support Resize Al's batch-processing feature, letting
you process multiple images quickly and easily. And when used as a plugin to Photoshop,
Resize can handle layered files with masks, alpha channels, text, and adjustment layers in
RGB, CMYK, Grayscale and LAB modes. This makes it perfect for graphic artists and print
agencies.

Getting Help

You can find an extensive collection of & Learing Hub - 0 X
video tutorials and help documents in
the Help section of the ON1 website
(onlhelp.zendesk.com). This is the Quick Start

quickest way to dig into Resize. There, Videos covering everything you need to get up and running with ON1 Photo RAW 2021.

you can search our Knowledge Base for k w1y

Quick Start

frequently asked questions, and more.

Inside ON1 Resize, you can use the % S
Learning Hub to directly display videos [ Vo .41 .

for getting started with the app, search v i\
the ON1 online help system—including ;
with and online chat assistant—and the

ON1 Shop, where you can purchase
add-ons and courses for Resize.

Finding Your Photos

The Learning Hub is accessible via the
Help menu or from the Help icon at the
bottom of the left bumper panel.

The Learning Hub is available directly within ON1 Resize Al 2022, and includes links to
videos (which can be played directly in the Hub), ON1’s online help system, and the ON1
store.
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System Requirements

MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15, 11; Windows 10; macOS 10.15, 11; Windows 10, 11;
current maintenance releases, 64-bit current maintenance releases, 64-bit
only only

PROCESSOR Intel Core i5, Xeon or better processor; | Intel Core i7, Xeon or better processor;
Apple Silicon processor or Apple Silicon

RAM 8 GB 16 GB or more

HARD DRIVE 1.5 GB for installation 1.5 GB for installation

SSD drive

DISPLAY OpenGL 3.3 compatible video card OpenGL 4.2 compatible video card with
with 512 MB VRAM, 1280x800 2GB+ of dedicated VRAM, 1920x1080
resolution (at 100% scale factor) resolution (at 100% scale factor)

OPTIONAL APPLICATION Photoshop CS6 and above; Photoshop | Photoshop CC 2022
Elements 14 and above; Photoshop Photoshop Elements 2022

INTEGRATION Lightroom Classic 6 and above Photoshop Lightroom Classic CC 2022
Capture One 10 and above Capture One 10 and above

INTERNET A high-speed internet connection and active account for activation, auto-update
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing.
Hardware display calibration tool is recommended.

LANGUAGES SUPPORTED English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian,
Portuguese, Italian, Dutch

llati
Installation

To install ON1 Resize Al 2022, double-click the installer icon and allow the installer to guide you. Before
installing or updating, close any supported host applications (Adobe Photoshop, Photoshop Elements,
Lightroom or Capture One), as well as any previous versions of ON1 products.

MACOS

The application is installed in the ON1 Resize Al 2022 folder in the Applications folder. All plugin files for
supported host applications found during the installation process will be installed automatically; a summary
of installed plugins will be displayed at the end of installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS

The application is installed in the ON1 Resize Al 2022 folder in the \Program Files\ON1\ directory.
All plugin files for supported host applications found during the installation process will be installed
automatically; a summary of installed plugins will be displayed at the end of installation.

Support files are installed into \ProgramData\ON1\.

ONI1 Resize Al 2022 User Guide
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UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Resize on your computer, the installation process will move over any
crop presets.

Licensing and Registration

When you first launch ON1 Resize Al 2022, the upper left side of the main window will have two buttons,
Buy Now and Sign-In.

IF YOU HAVE PURCHASED ON1 RESIZE Al 2022:

Click on the “Sign-in” button and fill in your ON1

account information (email and password) to register Buy Now - 14 Days Left1 Sign-in
the app with us. (You should have set up an account

when you purchased the software.) If the computer Nav Levels Info

you are signing in with does not have access to the —

internet, you can manually register your software by 24 mm (Sony FE 24-105mm F4 G 0SS)

clicking on the “No Internet connection” link in the 3/4/2022 4:49:25 PM

license dialog. 8640 x 5760 + 57.7 MB + RAW

Your license lets you install ON1 Resize Al 2022 on

two computers. When you enter your ON1 account

info. Resize Al 2022 communicates with the ON1 When you first launch ON1 Resize, sign in with your ON1 User ID
’ (which you set up when you purchased the software) If you downloaded

activation server and registers your software for that the app to try out, you can see how many days are left in your free trial.

computer.

ISO 100

If you wish to move your copy of Resize from one registered computer to a new one, and you are not going
to be using the older machine, it is best to sign out of the old computer first. Open Resize and select Sign
Out from the Help menu. This will deactivate Resize Al 2022 on the current machine, and you can install
and sign in on another machine.

You can log into your ON1 user account area (www.onl1.com/login/) at any time to download the software,
see the number of computers you have registered, and make basic changes to your account information,
including your email address, password, and notifications.

If you have issues related to installing or activating Resize, please contact ON1 customer support, which
can be reached by clicking on the ON1 website's Support tab (on1lhelp.zendesk.com).

TRIAL VERSION

ON1 Resize Al 2022 can also operate as a fully featured trial version for 14 days from when you first launch
it. This gives you time to evaluate the product and see if it fits your needs. Each time you launch Resize
during the trial period, the Buy Now button will tell you how many days remain in the trial.

You can purchase ON1 Resize Al 2022 at any time by clicking on the Buy Now button. Once you do that,
click the Sign-In button the next time you launch the product and enter your ON1 account information. If
your trial period has ended, Resize will present you with an activation window when you launch the app.

There, you can enter your ON1 account info to activate the app.
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PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the
Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you
use our programs and basic information about your computer. This information helps us learn what features
are important to you and how we can make our software easier to use. No personal information is collected
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Resize Al
2022. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 Resize Al 2022

To uninstall ON1 Resize Al 2022, first deactivate your product: open ON1 Resize Al 2022 and select Sign
Out... from the Help menu. (This will allow you to transfer your license to another computer.)

MACOS

1. Go to the Applications/ON1 Resize Al 2022/Documentation folder.
2. Double-click on the Remove ON1 Resize Al 2022 application.

WINDOWS

1. Go to Control Panels.
2. Under Programs select Uninstall a program.

3. In the list that comes up select ON1 Resize Al 2022 and then click on the Uninstall button.

Working with Files

ON1 Resize Al 2022 can view and open the following file types, in RGB color, at either 8/16 bits per pixel:

e Raw files from most major camera manufacturers (file extension varies by manufacturer)
e Digital Negative (DNG)

e Photoshop (PSD)

e Photoshop Large Document (PSB)

e Tagged Image File Format (TIFF)

e Joint Photographic Experts Group (JPEG)
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e Portable Network Graphic (PNG)
e High Efficiency Image Format (HEIC)

When you wish to export or share images, Resize can save files in PSD, PSB, TIFF, JPEG, PNG and DNG
formats. (See page 33 for information on Resize Al's Export feature.)

Launching Resize Al as a Standalone App
To launch Resize Al 2022 as a standalone app, follow these steps:

MACOS

Open the Finder, and navigate to the Applications folder. Find the ON1 Resize Al 2022 folder and double-
click on the Resize Al 2022 icon. You can also add ON1 Resize Al 2022 to your dock (or Launchpad) for
easy access by clicking and holding the icon in the dock and selecting the Keep In Dock option.

WINDOWS 10

Open the Start screen by pressing the Window key, and select ON1 Resize Al 2022. If you selected the
“Add Icon to Desktop” option during installation you can also access Resize from there.

OPENING PHOTOS FROM WITHIN RESIZE Al

When you first launch Resize Al, the main Az
window will have an icon in the center and an
Open Photos button. To start working on a
single photo, you can either click the button
and choose the photo from your computer’s
file-selection window or drag a photo from
your desktop into the Resize window. To work
with multiple photos, you can drag a folder

or selection of files into the window, or click
the Open Photos button and select a folder
or multiple items within a folder using your
system’s file-selection tools. (See page 27 for
detailed information on working with Resize Al once you have opened a photo or group of photos.)

You can also drag a photo on top of the Resize Al 2022 icon, which will launch the app with that image,
bypassing the startup window.
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Using Resize Al as a Plugin

In addition to using ON1 Resize as a standalone app, you can easily export single photos to Resize
from Adobe Photoshop, Photoshop Elements, Lightroom Classic and Capture One. When working with
Lightroom Classic or Capture One, you can also batch-process multiple images inside Resize Al.

USING RESIZE WITH ADOBE PHOTOSHOP

ON1 Resize Al 2022 is accessible from within

Automate Batch...

>

Photoshop via the File > Automate menu. Selecting Scripts > PDF Presentation..

. . . . . Import > Create Droplet...
that item will open the image in Resize. When you R TR 5 :

.. .. . . Crop and Straighten Photos
are finished resizing your image, clicking the Done \F/lfslzf:ﬁ'stor o Substance Sute

. . . . . i istory
button inside Resize will apply the transformation o o | _ONTNoNoise A1 2022..
. rint... n

and save it back to Photoshop at the new Print One Copy ST

dimensions. (Clicking Cancel inside Resize will close
the file without making changes.)

Resize supports layered Photoshop files with masks, text, and adjustment layers in RGB, CMYK, Grayscale
and LAB modes. All layers — including hidden ones — are preserved in the resizing process.

USING RESIZE WITH PHOTOSHOP ELEMENTS

ON1 Resize Al 2022 is accessible from within Import >
the Photoshop Elements Editor via the File > - )
. . e ON1 Resize A1 2022..
Automation Tools menu. Selecting that item will orint w%p
rint...
open the image in Resize. When you are finished Order Prints... >

resizing your image, clicking the Done button
inside Resize will apply the transformation and save it back to Photoshop at the new dimensions. (Clicking

Cancel inside Resize will close the file without making changes.)

NOTE: The Automation Tools submenu — used to send a photo from Elements
to Resize — is only available when working in the Expert tab of the Elements
Editor app. In addition, layered files are not supported from within Elements;
you must flatten the layers before any image can be sent to Resize Al.

USING RESIZE WITH LIGHTROOM CLASSIC

ON1 Resize Al 2022 can be accessed from within Lightroom Classic CC, providing an integrated, round-trip
workflow of your images. There are two primary ways to use Resize with Lightroom, via the Plug-in Extras
command in the File menu and the Edit In command in the Photo menu. Both generally work the same way,
the primary difference being where you choose the file format of the photo being opened in Resize, and
that you can batch-process multiple photos via Plug-in Extras. Using Plug-in Extras opens the file using the
format chosen in Resize's Plugins Preferences pane, while Edit In uses Lightroom’s export facility to send a
single image to Resize.
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If you use Resize as a plugin from Lightroom, we recommend using the Photoshop format (.PSD) as the

exchange file format for maximum compatibility. If your saved file will be larger than 2GB, or more than
30,000 pixels on a side, your image will automatically be saved in the .PSB (or Large Document) format.
This is a version of the PSD format designed for larger file sizes, and is fully compatible with Resize.

Plug-in Manager... Edit In > Edit in Adobe Photoshop 2022...
Plug-in Extras > Photo Merge > Edit in Other Application...
ON1 Resize Al 2022 B
Show Quick Collection ON1 NoNoise Al 2022
Create Virtual Copy ON1 Resize Al 2022
Rotate Left (CCW) Open as Smart Object in Photoshop...

You can access Resize from Lightroom Classic from either of two submenus, File > Plug-in Extras (above, left), or Photo > Edit In (above, right). There
are small differences between the options, but both will get you to Resize quickly. Which one you choose is open largely to personal preference.

Using ‘Plug-in Extras’

To edit an image in Resize, select the image in Lightroom, go the File menu and select the Plug-in Extras
submenu, and choose ON1 Resize Al 2022.

When you access ON1 Resize Al 2022 through "o Preferences

the Plug-in Extras menu there are file-handling . SUNERY o BB
options that are controlled in the Plugins tab of e R A AP G B
the Resize Preferences window. These should Photoshop

be configured in advance, based on your desired Apply Resultsto  Copy of the Current Layer )
workflow. Once these are set, all images sent to @ Start vith the Last Used Settings

Lightroom

Resize Al 2022 via the Plug-in Extras submenu
will use these characteristics:

File Type  PSD (Supports Layers, Default) a
2]

Color Space  Adobe RGB 1998

. . Bit Depth  16-bit
e File Format: Determines what type of
. . N Resolution 300| pixels/inch (]
file will be created. The default is PSD. 9 stack with O
ack with Original
You can also select JPG or TIFF. € Use Original for Single PSDs
Ask Every Time
° : i
Color. Space: Deterrmnes what RGB .
Worklng color space Is used; Adobe When sending a file from Lightroom to Resize via Lightroom's Plug-In Extras *
menu, the edited file will be created according to your settings in the
RGB 1998’ SRGB or ProPhoto RGB. Lightroom Plug-Ins section of Resize’s Preferences window (highlighted above
e Bit Depth: The bit-depth drop-down in red).
menu determines the bit depth (8 or 16 bits per pixel).
¢ Resolution: Determines the resolution of the file. i N—
e Stack with Original: When enabled, the new image What to Edit
is stacked with the original image upon return to OFF iteicoymnl Ditoomeings _
This creates a.copy in the fll.e format gnd options pased on the apgl\catlon
nghtroom from Res'ze. z;zfgzr:\(;e:::l:zizréyn\;g‘see-nmgs applied. The settings are cooked into the

Edit a Copy

e Use Original for Single PSDs: When enabled, if you
select a single image in PSD format, the original file
will be edited, rather making a copy.

This creates a copy in the file format and options based on the application
preferences with no Lr settings applied.

e Ask Every Time: When checked, Lightroom will —
present these export copy options whenever you File Format: _Photoshop (Supports Layers) [
chose an item from the Plug-In Extras submenu. Color Space: | Adobe RGB (1998) [
Turning this option off will bypass the file-export Bit Depth: 16-bit | Resolution: [300 | _pbeelsfinch [J
window inside Lightroom, using the options set in @ sk Every Time e —

Plug-In Preferences window.
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If you have the Ask Every Time option checked, you'll be presented with the Export Options window

inside Lightroom whenever you send an image to Resize (shown on the previous page). The Export Options
window lets you adjust the file format characteristics as needed, and is designed for users with variable
workflow needs. If you find that you use the same options every time, then you can set those parameters in
Resize' Preferences window by unchecking the Ask Every Time option.

Batch processing multiple files with Plug-In Extras

You can batch process multiple images for resizing via Plug-In Extras. Select the images you wish to work
with in Lightroom’s Library module and choose Resize from the Plug-In Extras submenu. The Export
Options window will open with two batch options:

Pause on First Photo: Use this option when you wish ~ * Export Options
to apply the exact same editing operations to a group of

photos. This option will open the first selected image Batch Options

inside Resize. There, perform any editing option you © Pause on First Photo
wish, including applying presets, any cropping, and
other adjustments in Resize. When you have finished

Pause on All Photos

. . . . . i Cancel K
with your edits, click Done. Resize will then apply all Ask Every Time ance
. . . ey S X ) i 4
of the edits — including the exact crop position — to The Batch Options window comes up when you wish to
. . . send a group of photos from Lightroom to Resize. (If you
each image in the group, and return you to Lightroom. have the Ask Every Time option set in Resize’s
. . . Preferences, Batch Options will be displayed as a
Pause on All Photos: This option lets you sequentially section in the Export Options window..)

edit the images in the batch. Resize will open each

image in the destination tab, where you can edit it as desired. When you are finished editing
with one photo, click Done, and Resize will save that photo and open the next one, with

the previous photo’s Resize settings applied. (You can reset any or all of those settings as
desired.) When you have finished editing the last photo in the group, clicking Done will save
the image, close Resize and return you to Lightroom.

Using ‘Edit In’
When you use the Photo > Edit In submenu, Lightroom will ask r Edit Photo wiith ON1Resize Al 2022 A
you each time for the resultant format how you wish to edit the e
What to Edit
selected image. You have three choices: N S
e Edit a Copy with Lightroom Adjustments, which
makes a copy of the file that includes any edits you
have made in the photo;
e Edit a Copy, which copies the original photo without
any changes made in Lightroom; or
¢ Edit Original, which sends the original version of the ¥ Copy File Options
photo to Resize, unless the photo is a raw file, in which e Formst L PSD 8
case the option will be unavailable. Golor Space: | Adone RoB (1995) @
Bit Depth: 16 bits/component 2]
Resolution: 300
In the Copy File Options, you set the file type (TIFF, Photoshop
PSD or JPEG), the color space and bit depth for the resultant file.
Cancel m
When you have set your options and click the Edit button, k J

Lightroom will create a new file (or send the original) and launch
Resize. When you're finished, click the Done button to save your changes, close Resize, and return the file
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to Lightroom. To return to Lightroom without saving your edits, click Cancel. Note that, because ‘Edit In’
causes Lightroom to create a file before it gets sent to Resize Al, that new file will remain in your Lightroom
library. (If you cancel in Resize when using Plug-in Extras, Resize will not send the canceled file back to
Lightroom.)

USING RESIZE WITH CAPTURE ONE

When you edit an image sent from Capture One to ON1 T
Resize, Capture One creates a variant of the current photo. To Format (PSD
resize an image inside Capture One, follow these steps: e

Resolution 300 pxfin O
Scale  Fixed

1. Open the image in Capture One. 100 %

v Adjustments

2. From the Image menu, select Image > Edit With > U
rop lespect crop
ONl Resize AI 2022. Sharpening No Output Sharpening

> Metadata

3. Choose the file characteristics you wish to use
in Resize—File Type, Bit Depth, ICC Profile, and
Resolution—and click the Edit Variants button to
launch Resize.

When you're finished editing your photo, click the Done button
in Resize. Your variant will be visible in the current collection. cancel NS

Batch processing Files in Resize with Capture One

You can process multiple images for editing in Resize with Capture One. Select the images you wish to work
with in Capture One and choose Image > Edit With > ON1 Resize Al 2022. The Export Variant window will
open with an additional tab, ON1 Batch, which contains a pop-up with two options:

e Pause on First Photo: Use this option when you ~ ON1 Resize Al 2022
wish to apply the exact same editing operations to = SR
a group of photos. This option will open the first Pause on All Photos
selected image inside Resize. There, perform any
editing option you wish, including adding filters,
applying presets, retouching operations, cropping,
masks, local adjustments and more. When you have
finished with your edits, click Done. Resize will then oy m——
apply all of those edits to each image in the group, Format  pSD
and return you to Capture One. e

ON1 Batch

Resolution 300 pxfin ¢

e Pause on All Photos: This option lets you R
sequentially edit the images in the batch. Resize will
open each image in the destination tab, where you
can edit it as desired. When you are finished editing
with one photo, click Done, and Resize will save that photo and open the next one, with
the previous photo’s Resize settings applied. (You can reset any or all of those settings as
desired.) When you have finished editing the last photo in the group, clicking Done will save
the image, close Resize and return you to Capture One.

100 %

> Adjustments

Cancel Edit Variants

Before sending multiple images to Resize from Capture One, you can also click on the Basic, Adjustments
and Metadata tabs to change those options. Once you have all the options chosen, click the Edit Variants
button and Resize will process that group based on your batch settings.
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Extras

ON1 Resize Al 2022 supports two additional file 280 Exras Manager
types that can be used within the app. These files e
. . ™ Canon Canvas @ Epson 8x8 Gallery Wra
are called Extras, and the file types include: 1 Conontatte 8 conen 5010 cateny Wi
#® Canon Resin Coated @ Epson 8x12 Gallery Wrap
o Resize Presets, specific crops for a wide B Epsn Matte 8 Epson 11314 Gallery wrep
m Epson Resin Coated @ Epson 16x16 Gallery Wrap
H B HP Canvas @ Epson 16x20 Gallery Wra
range of paper and printer types for use o e B e e
within the Resize module (see page 26). 15 140 Reein Costed =§§j::§§j§j§:::jm:§
X X m Video @ Epson 20x30 Gallery Wrap
e Watermarks, image files (transparent 8 Web & Email 8 Epson 20x24 Gallery Wirap
@ Epson 24x30 Gallery Wrap
PNGs) that can be used with the @ Evson24x36 Calery Wiap
@ Epson 30x30 Gallery Wrap
. ) @ Epson 30x45 Gallery Wraj
Watermark pane of Resize’s Export (page B e s oo
37) and Print (page 46) features. M Epson 40,50 Galery Wrap

@ Epson 40x60 Gallery Wrap

You can import, export and manage presets and
watermark files via the Extras Manager, which is
available when you have a photo open in Resize. ‘

+ | — | Import | Export

To import extras, choose Manage Extras from the File menu, then click on the Import button in the footer
of the left column. A dialog box will appear where you can select the files to import. If you want to import
an entire folder, open the folder, select the first file, then shift-click on the last file. Click Import when your
selection is complete. Then, select a category for your extras to live, which is where you will be able to find
it inside Resize. You can select from an existing category or create a new one.

ORGANIZING PRESETS

When you are in the Extras Manager, you'll see ‘+’ and -’ buttons, which let you add or delete categories to
the list of your presets. You can also add subfolders to any of the categories, which can help organize and
manage large collections of presets. You can use drag-and-drop to move existing categories into another,
or you can add a category subfolder to an existing category by clicking on the category and then clicking
on the +' button in the Extras Manager window. (When you are importing presets, Resize gives you the
opportunity to add presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets,
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete
category, click on the category in the list on the left side of the window and click on the Export button.
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that

category. If you would like to export a single preset, click on the preset from the list on the right side of the
window and click Export.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager in any module (File > Manage Extras).

2. Click on the extras type that contains the content you wish to remove. This will display
categories within that type.
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3. To delete an entire category, select in the left column and click on the Delete button in the
footer of the left column.

4. To delete individual extras, select them in the right column and click on the Delete (‘—' in the
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.

Customizing Resize’s Keyboard Shortcuts

You can customize ON1 Resize Al 2022’s hotkeys Keyboard Shortcuts
via the Keyboard Shortcuts window. This window

lets you view and change the shortcuts for any tool,
tool option, module, or menu item inside Resize. You

DISEN v | Summarize

Q

can assign shortcuts to items that don’t yet have a CETER Shorteut
odules

shortcut, build multiple sets of shortcuts as preset :Iools

styles, and create a summary of your shortcuts that Crop

. N 74
can be viewed in any web browser. eom

Menu
File

To view or change Resize’s hotkeys, choose Keyboard Edit
Shortcuts from the Edit menu. By default, Resize’s Settings
. . . . . Reset All Settings
shortcuts will be displayed, organized hierarchically S ———
by the following groups: Reset Crop
Copy Settings
e Modules, which is inherited from ON1 Paste Settings
. . . Paste Settings from Previous Edit
Photo RAW, and is not used in Resize Al. Sync Settings

Sync All Settings

e Tools, for the Crop and Zoom tools.

Save Settings as Preset

. . . Update P t with C t Setti
e Menu, which includes all of Resize's menu T e
Rename Preset

items. Delete Preset
Export Preset
Import Preset

You open each group by clicking on the triangle to
the left of the group name, or you can use the search
field at the top of the Keyboard Shortcuts window to
search for a command in any of the groups.

Get More Presets

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu
commands used by the operating system (Cut, Copy, Paste). Also, you can’t use
the Escape, Return/Enter, or Delete keys as a shortcut.
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MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be modified, but you can create your own set of shortcuts by
double-clicking on any command you wish to add or change. You'll be asked if you want to create a new
preset. Clicking Yes will let you name the new preset style, and Resize will make a duplicate of the Default
set.

At this point, you can change any existing hotkeys—or add your own shortcuts for commands that don't
have them—by double-clicking in the Shortcut field for that command. The field will be highlighted, and you
can press the key or key combination you wish '® 1
to use. If that key is used by another command, a
dialog will come up, informing you of that, and
giving you the option of either keeping the
existing hotkey/command combination, or
changing it to the new command.

The factory preset 'Default' cannot be modified.
Ap Would you like to create a new preset?

No \CS

When you add or change a hotkey the first time, Resize will prompt you to

When you cha nge a defau|t ShOFtCUt to a new create a new preset style, which makes a duplicate of the Default preset. You
. . can switch between preset styles—including back to Resize’s Default set—by
key combination—even for commands and using the pop-up menu at the top of the Keyboard Shortcuts window.

options that didn’t initially have a shortcut—a
Reset arrow will appear to the right of the ] \

. L. . . ®
Shortcut field. Clicking the icon will reset the
command to its Original state, from the Default The keyboard shortcut ' XJ' is currently used for the
Ap 'Show Clipping’.
preset Style' Would you like to clear the keyboard shortcut for 'Show Clipping'?
To delete a shortcut, double-click in the Shortcut Cancel

field and press the Delete key.

L
If you try to add a shortcut key combination that is already in use, Resize will

. let you know, and give you the option of keeping (Cancel) or removing (OK) the
The Summarize button at the top of the other command/shortcut.

Keyboard Shortcuts window will create an
HTML table of the current set of hotkeys. You'll be asked where to save the file, and double-clicking on it
will open that table in your default web browser, where you can view or print the list.

You can return to the original Resize shortcuts by clicking on the pop-up menu at the top of the Keyboard
Shortcuts window, and choosing Default from the list of preset styles. That menu can also be used to
create a new preset or to delete an existing one that you created. The Default preset cannot be removed,
however.
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PART 2: USING ON1 RESIZE Al 2022

size Al 2022 (SF2013-0021.psd @ 25.0% 16-bit)

Fit |100] 50 | 25

ON1 Resize Al provides you with an easy-to-use work area for editing your photos. Below is an overview of
the main sections, including:
A. Tool Well: Includes the Crop and Zoom tools.

B. Settings/Help: Buttons for accessing Resize Al's preferences and help windows. The button
at the bottom shows/hides the Presets pane.

. Presets: A library of presets for different printers, paper types and print sizes.
. Search Box: Search for presets by name.

. Preview Window: Preview of image to be resized.

m m g 0

Zoom Level/Split Screen/Soft Proofing: Controls for setting the zoom level; displaying a
split-screen (before/after) view; and for turning soft proofing on or off.

G. Tool Options bar: Lists options for the current tool.
H. Navigator/Levels/Info Pane: Navigator, levels (histogram) and general photo information.

I. Photo Size: Displays the pixel dimensions of your photo, and lets you adjust the dimensions
for the resized image.

Settings: For selecting the resizing method and adjusting smoothness in the final image.
. Sharpening: Sets sharpening options for the resized photo.

Film grain: Adds realistic film grain to the final image.

r i

.Tiling: Lets you tile the finished image into a series of individual files for assembling into a
mural or other oversized print piece.
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N. Gallery wrap: Sets a custom border on the finished image for use when printing on canvas.

O. Reset All/Cancel/Done: Reset all settings; cancel and return to the startup window or
external application without saving; save and close open images with the current settings.

P. Print/Export/Share: Prints the current image (or selection, when multiple images are
selected); opens the Export window; lets you share your image (MacQS only).

Basic ON1 Resize Al Workflow

The power of Resize Al is in the concept of resolution on demand; Resize should be used as one of the last
steps in your workflow before printing. You can work with a modest size file, which makes your editing
faster and takes less hard drive space and memory. Then when you are ready to output your file, enlarge

it with Resize Al to the desired size and sharpen it for output. This means you don't have to keep multiple
versions of a file at different print sizes; you just create what you need on the fly. ON1 Resize also supports
layered Photoshop files so you can maintain all your layers in the entire process.

When working inside Resize Al — whether in standalone mode, or when using it as a plug-in — you have
multiple options for resizing:

e You can use the Crop tool to crop to a specific paper size;

e You can adjust the output size (with or without cropping) by using the Photo Size pane at the
top of the Resize panel; or

e You can use Resize Al’s built-in presets to crop and resize images to a specific printer, paper
type and print size. Presets can include everything from specific crop and paper sizes, output
sharpening parameters, film grain settings and more.

All of these methods can be edited and changed as you work. Once you've set your output dimensions, use
the Sharpening, Film Grain, Tiling or Gallery Wrap panes as needed. The Preview window updates as you
adjust your settings, and you can go back and forth between the original and edited versions of your image
as you work, either in a direct before/after view, or in an adjustable split-screen view.

When you've finished making your adjustments, pressing the Done key will prompt you to save your image
— when using Resize as a standalone app — and return you to the opening screen; when used as a plug-in,
Resize will save your image and return you to the originating app.

When batch-processing multiple photos in Resize Al, the workflow is slightly different, depending on
whether you are using Resize in standalone mode or as a plug-in. For details on batch processing in
standalone mode, see page 27. For batch processing with Lightroom Classic, see page 9; with
Capture One, see page 10.

Navigating the Preview Area

The Preview area is the main section where you preview and work on images. You can use the View tool for
navigating this window.

This tool, which is the default tool selected when you open an image in the Resize module, adjusts the
magnification of the image in the Preview window. With the Zoom tool selected, click in the Preview
window to zoom in and center the image at the location clicked.
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Hold down the Option/Alt key to pan around the magnified image. You can also double-click the View tool
in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows every pixel. This is best
when examining small details, and when previewing the effects of Resize Al's sharpening and resampling on
your photo.

As you adjust settings in the Resize panel on the right side of the screen, the preview will be updated in real
time. If you're performing a significantly large resize operation, it can take a few seconds for the preview to
be updated completely.

You can use the Split Screen control at the bottom of the main window (shown below) to split the screen
into two panes: the one on the left will display the original (before) image; the one on the left will display
the image with Resize Al settings applied. You can use the square in the center of the screen to make one
of the panes larger, and can use the Zoom and Hand tools to view more detail or scroll around the image.
(Click the Split Screen button at the bottom of the window to turn it off.)

—0 [ A] Preview

NAVIGATOR, LEVELS AND INFO

At the top of the control panel on the right of the main window are the Navigator, Levels, and Info panes.
These four panes can be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image. The white
square region marks the image area that is visible in the
preview pane. You can pan view by clicking and dragging
inside the white region.

Levels

The bottom of the Navigator pane has four buttons:

e FIT: Zooms to fit the current canvas size.

Fit | 100 | 50 | 25

e 100: Zooms to 100%, or actual pixels.
e 50:Zooms to 50%
e 25:Zooms to 25%
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The Levels Pane

This gives you a color chart of the shadow,

highlight areas based on the image RGB values (often
called a histogram). This is useful to show areas within

the image that may be clipping, which can s
highlight or shadow detail.

The left side of the histogram represents the shadows,

mid-tone and

Levels

ignify loss of

while the right represents the highlights. At the top Red | Green | Blue

of each end is a triangle. If the triangle is lit, there is

clipping on that side of the histogram. Click

ing on the arrows will activate the clipping overlay. Areas of a

blue overlay will display as pure black; areas with the red overlay represent pure white. You can turn the
clipping view off again by clicking on one of the triangles. You can also temporarily enable clipping view by

holding down the J key at any time.

The bottom of the Levels pane displays the

The Info Pane

RGB values of the pixel underneath the current cursor location.

The info pane displays important photo metadata, Nav

including:

e Camera type

e File type

e Focal length and lens information
e Date and time captured
e Exposure information

e ISO

e Shutter Speed

e Aperture

e Exposure Value

e Filename

e Dimensions

e File Size

Sony ILCE-1
24 mm (FE 24-105mm F4 G 0SS)
3/4/2022 4:49:25 PM

8640 x 5760 * 149.3 MB + PSD

I1ISO 100
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CROP TOOL

The Crop tool is used to crop and resize the entire image. Resize Al's Crop tool removes any pixels outside a
crop box and changes the canvas size at the same time.

To crop the image, select the Crop tool. Then adjust the corner handles of the crop tool overlay. The area
outside the crop box appears darkened for guidance. You can resize and move the image inside the crop
box. When you are satisfied, press the Apply button in the Tool Options bar or press Enter.

The Crop Overlay in Resize.

Working with the Crop Tool Overlay

¢ Moving the Image: To move the image inside the crop box, click and drag inside the box. You
can also nudge the image using the arrow keys on your keyboard.

¢ Resizing a Crop Box: To resize the Crop Box, click and drag on any of the resize handles.
Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on a side
handle allows you to adjust that side. If you hold the shift key down while adjusting the size,
the proportions of the box are maintained. To rotate the crop box, move outside a corner
until the tool changes to rotate. You can also set the aspect ratio or size of the crop box in the
Tool Options bar.

Crop Tool Options Bar

inches pixels/inch v Reset | Apply

e Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size
presets.

¢ Width: Sets the width of the crop box.

¢ Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.
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e Height: Sets the height of the crop box.

e Units: Determines the unit of measure: Pixels, inches, centimeters, etc.

e Leveling tool: Click and drag this tool across an element in your image that should be level.
e Angle: See and adjust the angle of rotation.

¢ Rotate: Rotates the image 90 degrees.

e Cancel: Resets the crop tool.

e Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop tool works in three modes, which are all accessible via the Preset

Freeform

pop-up in the Tool Options bar: Original Ratio
1x1 (Square)

e Freeform: In this mode you can adjust the crop box any way you like. i 22233
(

The image will not be resized. Any area outside the crop box will be el
trimmed off. Use this mode if you just want to change the shape or ?'55:9”

recompose your image for general use. Belrer

Square

e Aspect Ratio: You can lock the crop box to an aspect ratio. This Video
makes sure the crop box shape doesn’t change, just the size. Use .
this option to trim existing pixels while maintaining a ratio without
resizing the image.

o Document Size Presets: These let you crop and resize your image
at the same time. If you know your intent is to print the image at The Crop tool preset pop-up
a certain size you can crop and resize the image at the same time. includes options for nearly every
. . aspect ration or print size.
Many common sizes are included plus you can create your own.

Leveling the Image

. . . Photo Size
The Crop tool has a special Leveling tool for automatically
rotating your image to be level. To access it, first select the File size: 854.30 MiB 16-bit (264%)
Crop tool, then perform the following: Pixel Dimensions:
Width Height
e Select the Leveling tool from the Crop tool 12960 8640
options bar. Your cursor will change to the

Leveling tool. Resize to Dimensions v

e Click and drag a line across your image that
should be level, either horizontally or vertically.
When you release the mouse the image will be
rotated automatically to the correct angle.

Common Sizes 24x36 v

Width Height

36 24 inches v

Resolution

Creating custom sizes 360 PIIE 05

You can create document sizes by choosing the Custom
option at the bottom of the preset pop-up. Resize comes with many commonly used print, paper and video
document size presets but you can also create your own:

e From the Preset pull-down, select Custom > Manage Custom Sizes. This opens the Custom
Document Size Presets window.
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e Click on the Add button. [ BN ) Custom Document Size Presets

. . . . Name Width Height Units
e Double-click on the highlighted untitled name M - rorama big 0 " ehes

and name your preset.

e Double-click on the width and height and fill in
the proper values.

e Click on the units and select the proper unit.

e Click on the OK button.

Add

PHOTO SIZE PANE I Cancel “

The Photo Size pane has two sections. The top portion displays the file size and pixel dimensions of the
photo as you edit it. The bottom section provides multiple options for resizing your photo.

When you first open an image, the information in the top section of the Photo Size pane will be that of the
original file; as you adjust the resizing options — via a preset, the Crop tool or the ‘Resize to’ portion of the
Photo Size pane — that information will change, reflecting the size and dimensions of the resized image.
(The original pixel dimensions and file size for the current image can be viewed in the Info pane.)

The ‘Resize to’ section of the Photo Size pane has seven options for resizing your images: Dimensions, Long
Edge, Short Edge, Width, Height, Megapixels and Percentage. Most of the ‘Resize to’ options will scale your
image proportionally; the Dimensions option is the only one that will open the Crop tool, because you are
choosing a specific output/paper size for the resized file.

Here are the specifics for the different scaling options in the ‘Resize to’ pop-up:

¢ Dimensions. Similar to the document size preset pop-up in the Crop
tool’s Options Bar (see page 19), Dimensions lets you size your
image to common paper and photographic print sizes, as well as any
custom sizes you have created via the Custom Document Size Presets
window. When you chose an option from the Common Sizes pop-up,
Resize Al will open the Crop tool, so you can crop your image to the
appropriate paper size.

Long Edge
Short Edge

Width
Height
Megapixels

| Percentage

¢ Long Edge and Short Edge. These options are useful when you want A
The ‘Resize to’ pop-up menu.

to lock one edge to a specific length or width and don’t care about

the sizing of the other edge. Simply choose which option is the

important one for your photos, and enter the desired amount in pixels, inches, centimeters or

millimeters. These options can be helpful when batch-processing a group of photos that have

different orientations, and you want them all to have the same dimension on the long or short
edge.

¢ Width and Height. Using this option will scale the current image based on your choice of
either the width or the height metric.

e Megapixels. Scales the current image to a specific megapixel count.

e Percentage. This option enlarges or reduces the size of the exported images based on specific
percentages. Numbers below 100 will reduce the image, while those above 100 will enlarge
the image.

All of the options in the ‘Resize to’ menu include a Resolution section, represented either as pixels/inch or
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pixels/cm. To the right of the field is a pop-up menu with common settings for various printers and other
output formats. (See “How Much Resolution Do | Need?” on page 30 for more
information on choosing the proper resolution and sizing for your photos.)

72ppi Computer Monitor
100ppi Billboard

You can readjust any of the options in the resizing section at the bottom of the gggppi EPSC’S” tﬁfget'_“‘”mat
) ) ppi Dye Sublimation
Photo Size pane. You can move between options, use the Crop tool, or even 300ppi General Photo Printing

choose a preset, and Resize Al will recalculate based on your new choices. ST e AP FliiE
360ppi Epson Small Format

The Resolution pop-up has

S ETTI N G S P A N E common print resolutions.

The Settings pane contains the controls for selecting the resizing
method (or algorithm) and its settings. There are four options in the
Method pop-up:

Settings

Method Resize Al 2022 (Standard) v

Smoothness

O

e Resize Al 2022 (Standard). This is the default (and
preferred) option when resizing images. It provides the ideal combination of noise reduction
and micro-contrast, giving you the best results for most photos.

e Resize Al 2022 (Faithful). This option provides slightly less noise reduction and micro-
contrast than Standard, although the differences will be subtle.

¢ Genuine Fractals. This is the classic, patented, fractal-based algorithm used in Perfect Resize.
It is included solely for backward compatibility with previous versions of ON1 Resize.

e Bicubic. This option is for downsizing images. It has no settings.

The two Resize Al scaling methods have a Smoothness slider, which is designed to reduce artifacts that
might appear in overly sharp areas of a resampled image. By default, this slider is set to 0.

Genuine Fractals settings

As noted, the Genuine Fractals resizing method is included solely for backward compatibility with previous
versions of ON1 Resize. If you wish to use it, there are three sliders for adjusting the resizing parameters:

e Texture. This controls the amount of detail in flat, non-edge areas of an image. Smaller
numbers (1-2) are good for images with large areas of continuous tone, while larger numbers
(3-5) are good for images with lots of small detail. Settings beyond 5 will often introduce a
bumpy noise pattern; it works best when your original image was from scanned film.

e Threshold: This controls the amount of hard edge detail that is enhanced. The default
setting is 25. Decreasing the threshold will focus the Genuine Fractals algorithm on edge
information. This may be useful for portraiture or for reducing noise in your image. Settings
higher than 25 will increase the amount of small detail in flatter areas of the image. Settings
as high as 100 are useful for highly detailed images (hair or feathers).

¢ Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use
the lowest setting needed.

SHARPENING PANE

The Sharpening pane contains the controls to add additional sharpness to your final image. You should use
this pane only after you have resized your image to its intended output size.
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The Styles area at the top of the pane lets you select preset sharpening options for fixing focus, screen
output, or print, and includes a pop-up menu with an array of sharpening options for different output
needs.

Sharpening
O] J

Resize Al features three sharpening methods:

e High Pass: High Pass sharpening is helpful when the
original image is not sharp. HighPass v

e Unsharp Mask: Similar to Photoshop’s Unsharp Mask N
function. Resize Al's sharpening is different in that it is
only applied to the luminance of the image, to prevent
color artifacts.

e Progressive: Similar to Unsharp Mask, except it sharpens
different amounts depending on the size of the details
in the image. Small details are enhanced more than large
ones.

Using the Sharpening controls can save you the workflow step of adding additional Sharpening before
printing and can help compensate for loss of sharpness due to dot gain from your printer. Sharpening
should only be applied at the end of your workflow just before printing. If you plan to do additional
retouching or compositing work after resizing your image, you should disable the Sharpening controls.

To sharpen your image for output, use these steps after you have your final image ready for output:

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in
the Navigator pane.

2. Enable the Sharpening controls by toggling the on/off control in the pane’s title bar.

3. Select the sharpening method that will provide the best results for your image. You may
need to experiment to determine this.

4. Adjust the amount slider to determine the amount of sharpening desired.

5. Use the Highlight and Shadow sliders to limit the sharpening from being applied to the
darkest and lightest areas of the image which can prevent sharpening of noise.

6. Similarly, adjusting the Skin slider can help protect skin tones from being oversharpened in
the resizing process.

FILM GRAIN PANE

The Film Grain setting controls the amount of simulated film grain il @t
to your image. Adding a modest amount of grain can make your
image appear sharper visually and can help hide imperfections such
as JPG artifacts. ON1 has scanned a number of popular film types
for their grain patterns, and has made them available in the Film Kodak® T-Max 100

pop-up.

Adding film grain can be especially useful for monochrome images,
and should be added just before printing. To add Film Grain to your
image follow these steps:
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1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in
the Navigator pane.

2. Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.
3. Choose a grain pattern from the Film pop-up.

4. Adjust the slider up or down until the desired amount of Film Grain is added.
You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.
NOTE: As is the case with the Sharpening pane, if you need to do further

retouching or compositing work in Photoshop (or other editing app) after
resizing your image, you should not use the Film Grain pane.
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ize Al 2022 (CRW_6292.psd @ 18.3% 16-bit)

Film Grain
Tiling

Tile Size:

The tiling feature in Resize Al divides an enlargement into smaller pieces so that the image can be printed
on a smaller printer. For example, you might want to create a mural that is 8 feet tall by 12 feet wide, but
your printer can only print 24-inch wide strips. With the tiling feature you could automatically create six
separate files that are 24 inches wide and 8 feet (96 inches) tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you will print on, and if you would like the
pages to overlap. Then Resize Al will resize your image and section it into the individual tiles. When you
save or export the resized and tiled image, Resize Al will save the individual sections as separate files.

To use the Tiling pane:

Tiling
1. Turn Tiling on by toggling the button in the pane header. [
Width |8 inches v
2. Set the Width and Height fields to the size and y ,t _
eight |10 inches v
orientation of paper that you wish to print on, or you Overlap|0 e v
can select the number of rows and columns instead. Tile Count 15

3. Set the Overlap size. The overlap makes each tile
overlap so you can tape multiple panels together and corrects for printer margins if you are
not printing borderless.

4. Set the file type for the newly created files for each tile.

5. Set the destination folder for the new files. Each file will be named with the original filename
and the tile indicated in the filename.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will
tell you how many tiles will be created.
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GALLERY WRAP

esize Al 2022 (CRW_6292.psd @ 17.4% 16-bit)

“n Zoom| 17.37 Fit [100] 50 | 25

Settings
Sharpening

Film Grain

Tiling

Gallery Wrap

Reset All Cancel Done

The Gallery Wrap feature is designed to help you print on canvas. When making enlargements for canvas it
is common to wrap a portion of the image around wooden stretcher bars. These can be several inches thick
and help mount the canvas. These are commonly called gallery wraps. However, if you had important detail
near the edges of the image, it might be lost in the wrapping process. Resize Al's Gallery Wrap feature
automatically creates extended margins by reflecting or stretching the areas near the edge of the image
without having to sacrifice any of the original image. You can select the thickness of the mounting bars and
use different options for creating additional margins.

To use the Gallery Wrap feature:

1. Turn on Gallery Wrap in the pane’s title bar.

Gallery Wrap

2. Set the Thickness control to the amount of margins you
would like to add. A good rule of thumb is to use the
thickness of the stretcher bars, plus half an inch.

Type Reflect v

Thickness |2 inches v

3. Select the Type you would like to use (see the list below Wrap Overlay.

for details on the different options). s::::yy Coler

4. If you wish to add a color overlay to the gallery wrap )
wings set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap:

e Reflect: Copies an area equal to the thickness setting around your image, then flips each side
and adds it as the margins. This is a good general-purpose technique.
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e Reflect Soft: Does the same as the Reflect method but softens the added margins.
e Stretch: Takes a small area around the edge of the image and stretches it to add the margins.

e Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for

most gallery wraps.

You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders.
(The Opacity’s default is 0, which means that there is no color overlay added.)

PRESETS

Resize Al's preset system is designed to help you get very specific
crops for a wide range of paper and printer types. These include
settings for photo lab print sizes, and for Epson, Canon and HP
desktop-size and large-format printers, with matte, resin coated
(photo), and canvas paper types.

In addition to being able to set document size and settings, and
settings in any of the other panes, Resize presets always contain

a Crop adjustment. What that means is that any time you apply a
preset, Resize selects the Crop tool and places the crop overlay on
top of your file. There, you can move the overlay to the appropriate
crop area (or resize the crop) for your photo.

To apply a preset, choose the category you would like to use from
the Presets panel. The category will expand to a list of the available
presets for that group. Then, just click on the preset you want to

apply.

Saving a Preset

Presets

Canon Canvas
Canon Matte

Canon Resin Coated
Epson Canvas

Epson Matte

Epson Resin Coated

HP Canvas

HP Matte

HP Resin Coated
Photo Lab

Video

Web & Email

You can create your own custom presets for specific print or output types. Once you have your settings
that you wish to save, go to the Preset menu and select Save Preset, and choose a category you would like
to save it in. If you have applied a preset to an image and make adjustments to any of the settings in the left
panel, you can update that preset with the new setting by choosing Update Preset with Current Settings

from the Preset menu.

To delete a preset, right-click on the preset in the Presets Browser and choose Delete Preset.

NOTE: You can also import and delete Resize presets from within the Extras

Manager. See “Extras” on page 10 for more.
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Batch Processing in Resize Al (Standalone)

When you use Resize Al as a standalone app, you can open multiple images simultaneously, by either
dragging a folder or selection of files into the startup window, or by clicking the Open Photos button and
selecting a folder — or multiple items within a folder using your system’s file-selection tools. Once open,
you can work on each image individually, or you can adjust the settings for one image and sync those
settings to all (or some) of the images in the selection. When you're finished with your session and click
Done, Resize Al will export the collection via the Export window (see page 33 for more on Export).

Gallery Wrap

When you open a group of images in Resize Al, a filmstrip appears at the bottom of the window, displaying
each image with its original pixel dimensions and its resized dimensions (once you have applied Resize
settings). All of the images will be selected, highlighted with your operating system’s highlight color, and the
current image — the one visible in the Preview area — will have a bolder highlight around its thumbnail in
the filmstrip. You can move between images by clicking on them in the filmstrip or by using the arrow keys.

With the open images, you can adjust the resize parameters for each image individually, by moving from
image to image, or you can edit one image and click the Sync option at the bottom of the Resize window to
copy that image's resizing option to all of the other selected images in the group.

NOTE: When you use the Sync Settings option, all of the properties of the
current image — including crop and crop position — will be applied to the
selection. The crop is re-editable on any image during the session, however.
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Some additional notes about batch-processing images and working with the filmstrip:

e By default, all of the images in the group are selected, with the current image highlighted in
bold. You can deselect an image in the group by Control-clicking (Windows) or Command-
clicking (Mac) on it in the filmstrip. This can be helpful if you wish to sync only some images in
a group, or remove any images from the export group (see below).

e Clicking on a deselected image in the filmstrip will then select only that image.

e When you click Done, only the selected images will be exported. If you have made changes
to the selection during your session, and want to export the entire group, use the Select All
command to select all images in the filmstrip (Control-A for Windows, Command-A for Mac).

o The Reset All command only works with the currently selected image. If you need to reset all
of your work, either choose Cancel (and reopen the batch) or click on each image and choose
Reset All from the bottom of the window.

DeathValley2018-0820.psd HartMt2016-0128.psd joshua_tree_20200126_0116.psd

.

Original 4032x3024 Original 7952x5304 Original 7952x5304

After you have resized your photos, either individually, or via the Sync command, the new pixel dimensions for each image will be
displayed at the bottom of each thumbnail in the filmstrip.

Soft Proofing in Resize Al

ON1 Resize Al’s soft proofing feature lets you see how a photo will look when printed, using the color
profiles that get installed with your printer. Soft proofing helps you determine where there might be issues
when you print, so that you can adjust your tone, color and effects to give you a print that is closer to your
editing vision.

Normally, when you're viewing an image in Resize, you are viewing it through the lens of your monitor’s
display profile. The color gamut of your computer’s display is wider than that of most photo printers, which
means that some colors you are able to view on-screen are not reproducible when you print. When this

happens, the color profile conversion that happens in the print engine will cause substitutions of colors that

the printer cannot print to the closest color that it can. This means that your image could have subtle (or
broad) shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by clicking on the soft proofing icon to the left of the
Preview button at the bottom center of the main Resize window. The background of the main preview
window will change to approximate the color of the paper you're profiling.

Additional soft proofing options are available underneath the Enable Soft Proofing command in the View
menu. The options are as follows:
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e Gamut warning: When checked, this displays a red overlay for colors in the image that are
out of gamut for the current print profile.

o Profiles: The Profiles submenu lists
the currently available printer profiles.
Choosing one will change the on-
screen display to use that profile.

¢ Intent: Resize offers two different
rendering intents when soft proofing,
used to convert the color from display
to print. Perceptual shrinks the color
gamut, which works to preserve the
relationship between colors in the
image. Relative only converts colors
that are outside the current color
gamut; this can sometimes cause two
colors, one in gamut, and one outside,
to be identical after conversion.

Neither rendering intent is perfect

or desired; it often is a matter of the
makeup of the image, your editing
intent, the paper being printed on, and
so forth. Often, you'll want to switch
back and forth between Relative and
Perceptual, seeing which gives you a
better print.

e Simulate Paper and Ink: Turning this
setting on will cause Resize to use the
white point for the chosen paper type
(instead of the white point of your
monitor), and the paper’s actual black
density (instead of the display’s black
point). If you're trying to match a print,
you will usually want this setting turned
on.

Adjusting images with soft proofing is often a
. . )
bit of trial and error. It's easy to get CaUght up These three screen shots show the results of soft proofing options, as viewed
in eIiminating Out-of-gamut colors, but most in Resize. The top image is with soft proofing off (and is using the display
. . color profile). The middle image is with soft proofing turned on, and using a
modern photo printers—both home printers and printer profile for Epson’s Exhibition Fiber Paper. The bottom image has the
online print services—do a pretty good job of Gamut warning turned on; out of gamut colors are highlighted by the bright

. . red overlay.
approximating colors properly.

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy
between screen and print.
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Understanding Resize Al: How Big Can | Print?

People often ask how big you can print with ON1 Resize Al. The simple answer is this: if your original photo
is sharp, with good details and little noise, you can print almost as big as you desire. The limitations are the
size of your printer or the capacity of your computer to work with large file sizes. In practice, however, even
the largest prints are rarely more than 400 percent larger than the original photo.

Historically, the standard viewing distance for photographic prints is generally considered to be twice the
diagonal measurement of a print. For example, the ideal viewing distance for an 8x10-inch print would be
slightly more than two feet away, while the viewing distance for an 80x100-inch print would be over 21
feet. That last distance might seem like a lot, but that’s the kind of mural — almost 9 feet tall — you would
see at an airport or shopping mall. (Keep in mind too that many photographers scrutinize their images closer
than standard viewing distances; most people don't get that close.)

Photos are perceived in color, tonality, textures, and sharpness. Other interpolation techniques maintain
color and tonality but sacrifice textures sharpness by “inflating” the image uniformly. The image still looks
similar, but will not be crisp. Depending on the amount of interpolation, this can be severe and noticeable
even at standard viewing distances. ON1 Resize Al maintains the color, tonality, textures, and sharpness of
a photo at all sizes. It can actually create new detail at the proper scale.

How Much Resolution Do | Need?

To answer this, you need to know two things:

1. The size of the print you wish to make.

2. The resolution that your printer needs for best results.

The size of the print can be as large as you would like, although, obviously, you will be limited by the
maximum print size of your printer (although tiling can help).

Resolution is the density of the pixels for a given measurement, usually in pixels or dots per inch (or
cm). Most modern inkjet printers print anywhere from 1200 to 4800 dots per inch, but what the printer
manufacturers really mean is 1200-4800 droplets of ink per inch. A common mistake is to set the
resolution of the file to the resolution of the printer. In all but a few specialty printer types (like dye-
sublimation) this will lead to huge files that will not print well, if at all.

The secret is that the human eye cannot see more than 250-300 pixels per inch, and the ideal resolution for
your files should be close to this. Once you know the print size and resolution, it is easy to use Resize Al to
scale your file to the desired output size. Simply enter the resolution and the output specifics in the ‘Resize
to' section of the Photo Size pane. You'll see that the corresponding dimension is automatically computed
by Resize Al based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors, and paper can all be
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5x11 inches or about
1:1.25. These kinds of proportion mis-matches are common and require that the original image be cropped
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition,
then you will need to adjust your print size to a longer dimension.
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Resizing an image larger than the original size requires new pixels to be created. This process is called
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most
common method used by many pixel-editing apps is called bicubic interpolation. Bicubic along with its
newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize Al uses a neural network trained on millions of examples of photos. It is fundamentally different
from bicubic or other interpolation methods. It can analyze the photo and faithfully recreate textures in
nature, at the proper scale, all while maintaining the sharp details and reducing noise and artifacts. All this
number crunching may take a bit longer than the single pass interpolation methods like bicubic, but good
things come to those who wait and the reward is far superior results.
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PART 3:
EXPORT, PRINTING AND SHARING



Export

Resize Al 2022’s Export window lets you export your photos with incredible flexibility, ease and
LTJ control. When using Resize Al with a single image, you can access the Export window at any
time from the File menu or the icon at the bottom right side of the window; when used in batch

Export
mode, the Export window is launched when you click the Done button at the end of a session.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel
contains specific types of options—file renaming, destination folders, file type and more—that you can use
when you are exporting images from Resize. If you find that you are using a specific set of options all the
time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:
Export - 1 Photo
Export Presets A Export Options

Dimensions in filename to s Hide Naming

PSD Adobe RGB (1998) 16-Bit Presets filename with dimensions
Current Folder

Example: image000000_686x916_-rszAl.psd

ReS Al co e Filenamev _ Export Dimensionsy _-szAl

PSD Adobe RGB (1998) 16-Bit
/Users/rk/resized

Extension Lower Case v Add Token...

Resized to Same Folder Destination

PSD sRGB IEC61966-2.1 16-Bit
Current Folder

Folder Same Folder as Original
Put in Subfolder | resized
Existing Photos  Keep Both
TIF to ZIP on Desktop Estimated Space Needed 5MB (Not Av:
TIF Adobe RGB (1998) 16-Bit
Desktop

Generate Subfolders

After Export:
n Finder
ate a ZIP Archive
Open in Adobe Lightroom Classic (Prerelease) v

Run a Script

File Type
File Type Photoshop v
Profile Adobe RGB (1998) v BitDepth
Flatten Layers
Estimated File Siz
Resize
Sharpening
Metadata

Watermark

Save Preset B Background Export ] Cancel Export

A. Export Presets: The current preset (if used), will be represented with a selection box around
it, and the filled circle to the left of the preset name means that it will be used when the
Export button is pressed. To use the Export Options panel without any preset applied, turn
off all of the presets in the list, and click in the current preset once.
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. Save Preset: Lets you save the current set of export options as a preset.
. Naming: Renames the exported file based on criteria added to the rename box in the panel.
. Destination: Lets you set the destination of the exported files. (required)

File Type: Sets the file type for each exported file. (required)

Resize: Not applicable in Resize Al, since the resizing operation is provided in the app itself.

. Sharpening: Applies sharpening to the exported images.

T O M mMmoON @

. Metadata: Adds/removes metadata from the export.

Watermark: Lets you add a text or graphic watermark to an exported image.

—

Export/Cancel: Starts the exporting, or cancels it and returns you to Resize.

Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any
combination of tokens and text in the entry box, and the Example label directly above the box will display
what your new filename will look like, using the
first item in the export group.

Naming

Presets shoot-camera-suffix

To use this feature, click the control circle to the
left of the label in the panel. Add any custom
text, or click the Add Token pop-up menu to add joshua_tree_ Model v _ Filename Number Suffix v
tokens based on information associated with the
image, including filename data, date and time
information, and associated metadata There are FigeEn  enerEs v
four submenus in the Add Token menu:

Example: joshua_tree_ILCE-7RM2_.dng

Add Token...

¢ Filename, which includes options for using the original filename, number suffix (taken from
the image as recorded by the camera) and enclosing folder name.

e Date/Time, which includes a list of date (year, month, day) and time data that can be
combined in various ways.

e Sequence, which adds an incremented number to each renamed file in the batch, as well as
the total number of files in the batch, with options for leading zeros in the resultant filename.

e Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item
above the text field will show a sample of a renamed file using the current set of tokens and custom text.
To change an existing token, click on the down arrow on the right of the token, which will display the full
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations
that you can use as a starting point. You can also create your own batch-rename presets: build the rename
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text
and token combinations give you the filenames you expect for your batch process, and adjust as needed.
When you're sure, click Apply, and Resize will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with
explanations, can be found on page 39.

DESTINATION
The Destination pane is where you set the Destination
desired location for the exported images. At Fefléer  Gee Rl o5 @
minimum, you must specify a destination folder Putin Subfolder |jpgs
for your export, but the pane has a number of Existing Photos _ Keep Both
options for adjusting the export location: Estimated Space Needed OMB (639.9GB Available)

e The Folder pop-up menu lets you
choose the same folder as the original
images, another folder, or, can be set
to ask for a destination every time,
which can be helpful when you're Example: /jpgs/2018/10/20
using an export preset.

Generate Subfolders

Presets

Year (YYYY) v Month (MM) v Day (DD) v

e Checking the Put in Subfolder option
will export the images to the folder—
or, create a new folder, if it doesn’t
exist—specified by option’s text field.

Add Token...

After Export:

e The Existing Photos pop-up is for
those times when there might be a S AP
naming conflict within the destination Openin  Adobe Lightroom Classic (Prerelease) v
folder. Replace will overwrite the file Run a Script
with the new one being exported, Skip
will leave the destination file alone
and not export the new file, and Keep
Both adds a number ‘1’ to the end of the filename of the exported file, preserving both files.

Show in Finder

e Generate Subfolders will subdivide the export based on the exported file’s metadata,
creating subfolders as necessary—or, if the folders exist, placing the exported file into the
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in
the Naming pane.

o After Export lets you determine what to do when Resize completes the exporting process.
This includes displaying the image location in the Mac Finder or Windows Explorer, to create
a ZIP archive of the exported group, to open in another editing application, or to run a script.
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FILE TYPE

Like Destination, File Type is the other required
element for using Export. Resize can export in
DNG, PSD, TIFF, JPG and PNG formats. With
the exception of DNG and PNG, each file format Profile sREB IECET966-2.1 N
has specific options in the pane: Felmated e Size S 2E

File Type

File Type JPEG v Quality

¢ Original includes options for embedding metadata and saving an ON1 sidecar file with the
exported images.

e JPEG includes options for JPEG quality and for attaching a color profile.

e Photoshop includes options for attaching a color profile, bit depth, and whether to flatten
any layers in the original image.

e TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit
depth, and to preserve transparency.

e DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

SHARPENING

The Sharpening pane has two modes, Sharpen
For and Manual. The Sharpen For pop-up
menu lets you choose from six options, based Sharpen for - Screen Low
upon your final intent. There are four options
designed for print output, Glossy Paper High
and Low, and Matte High and Low, and two
option for display output (for social media or Radius
online sharing), Screen High and Low.

Sharpening

v Manual

Amount

O
Threshold
—(©)

The Manual setting provides a bit more control
over the output sharpening, letting you adjust
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened
based on contrast).
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METADATA

The Metadata pane lets you set which pieces of
metadata are exported—or not exported—with
the images in the export set. You can choose to
export all Metadata or by clicking the control
circle to the right of the All Metadata label.

If you click that label off, you can then select
which metadata items you wish to save by
clicking the appropriate label.

When checked, the Remove Unmanaged XMP

Metadata

Presets None

All Metadata
Keywords
Description
Ratings Labels
GPS
User Comment

Camera Info
IPTC-
IPTC-
IPTC -
IPTC -
IPTC -

Contact
Content
Image
Status
Copyright

Remove Unmanaged XMP

button only exports standard metadata; any proprietary image metadata created by other apps will not be

included.

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for
size and positioning, opacity, font type, and more.
You can import your own logos and save either
watermark type as a preset for frequent use.

The Watermark pane also gives you a representation
of your chosen watermark (on the first image in your
export group), so you can adjust the parameters of
the watermark precisely.

To create a new watermark, turn on the pane by
clicking on the control circle to the right of the label.
Choose either a preset from the Presets menu or
click on the Add Watermark button in the lower
right of the pane and choose either Text or Logo
from the pop-up menu. Once you've selected a type,
the bottom of the pane will open with settings for
the chosen option. If you change your mind, click the
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you
use either watermark files imported via the Extras
Manager (see page 10), which will be displayed

in the File pop-up at the top of the Logo section, or
by clicking on the Import button to the right of the
menu (which will add them to the menu).

Use the Position grid at the bottom of the pane to

Watermark

Presets Made with ON1

v Logo

Appearance:
File O — Made_with_ON1 Import...
Size
®)
Inset

@)
Opacity

Position:

Repeat Image

place your watermark, and use the Size and Inset sliders to move it within the area chosen. The Opacity
slider adjusts the transparency of the watermark on the final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting

to social media—it needs to be the same size as what you are exporting for the web, typically over 1000
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency,
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text
section of the pane has an entry box for your
watermark text, a font selection area, and the same
Appearance and Position options found in the Logo
section.

The text entry box can contain multiple lines of
custom text, and has the same token-based naming
options found in the Naming pane (discussed on
page 34), which can be helpful when exporting
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and
the font color by clicking the swatch on the left side

underneath the font name. The text style can be > Text
set to bold, italic or underline, and the alighnment to Cottonwood Canyon
left, center or right. If you'd like to add a background Date (Month DD, YYYY)v  — Modelv

color to the text box, turn on the Color Fill button Lensv
on the right side of the pane.

Use the Position grid at the bottom of the pane
to place your watermark, and use the Size and

Inset sliders to move it within the area chosen. [ Color Fill
The Opacity slider adjusts the transparency of the P
watermark on the final image. Size
Inset
Saving watermark presefs —O
Opacity

Both watermark types can be saved as a preset
for re-use later. To save a preset, adjust your Logo
or Text settings as desired, and choose Save New
Preset from the Presets menu. If you wish to adjust

an existing preset at a later time—withanew logo m R eI e e e e e
file, for example—choose the appropriate preset data-driven watermarks (using tokens) for presentations and the like.
from the Presets menu, make your changes, and

choose Update Preset with Current Settings from the Presets menu. You can also rename and delete
watermark presets from this menu.

Position:
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Exporting and Export Presets

The Export window has been designed to offer as much or as
little complexity as you would like. At its simplest, you can set the
Destination and the File Type to your desired settings, leave all of
the other panes alone, and click Export.

Resize will remember your last Export setting—including anything
you did in the Naming pane—the next time you export, so you
don’t have to worry about which settings need to be set, and which
ones don’t. You can use the Show/Hide buttons in the title bar

of each pane of the Export Options panel to display only those

Export Presets

Dimensions in filename to s Hide

PSD Adobe RGB (1998) 16-Bit
Current Folder

ResizeAl to resized folder

PSD Adobe RGB (1998) 16-Bit
/Users/rk/resized

settings you want to see.

Resized to Same Folder

PSD sRGB IEC61966-2.1 16-Bit
Current Folder

Once you have your settings the way you'd like, you can save them
as a preset by clicking the Save Preset option in the Preset panel
on the left. Then, when you click that item in the Preset panel, the
Export Options will be set to the specifications of that preset.

TIF to ZIP on Desktop
The Export Presets panel will display a list of the currently TIF Adobe RGB (1998) 16-Bit

available presets. If you have selected a preset, it will have a Desktop
selection box (in the app’s accent color) around it, and if the control
circle is filled, the preset is on, meaning that clicking the Export
button will export using that preset. If you don't wish to use a
preset, click the control circles off on all of the presets in the list.

All presets include an informational view that lists
the export file type, the destination folder, and
resize information. If you don’t wish to see that,
click the Hide button to collapse the view to just
the preset title.

By default, each preset will have up to three lines of explanatory

text underneath the preset name, displaying the file type—DNG, PSD, TIFF—and the Destination
information. This can be helpful when you're scanning presets for a specific destination, but you can also
collapse the preset to its title by clicking the Hide button in the title bar.

When you change the settings for a selected preset, Resize will ask you if you wish to update the preset
with the new settings either when you click the Export button to start the process, or when you switch to
another preset with the Export window.

It is possible to export more than one preset at a time. Every preset in the Presets panel that has the
control circle set to On (filled) will be included in the export operation. This might be helpful to create
backups on another disk, for example, or to build proxy versions for use while the original is being edited.

About Resize Al’s File-Naming Tokens

When using the Naming option in the Export window, ON1 Resize Al includes a broad set of tokens that
you can use as part of the strings to build complex filenames, in conjunction with any custom text you wish
to use as part of the filename. These tokens draw on image metadata, including filenames, dates taken,
and the complete list of both EXIF and IPTC metadata fields. You can use these tokens in any number of
combinations.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item
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above the text field will show a sample of a renamed file using the current set of tokens and custom text.
To change an existing token, click on the down arrow on the right of the token, which will display the full
set of tokens. To delete a token, double-click on it and press the Delete key.

Naming

Presets

Example: JT_workshop_ILCE-7RM3_19Mar_%

JT_workshop_ [Model~ _ Day (DD)v Month (Mon) v _ Ratingwv

Extension Lower Case v

You can use a combination of tokens and custom text to rename files to exacting specifications, drawn
from file information, metadata and more.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence,
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the
filename or the enclosing folder that the file resides
in. There are three options, Filename, which adds the Sequence Number Folder Name

current filename of the file being worked on; Filename skt

Number Suffix, which takes the index (shot) number

from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the
renamed (or imported) file resides.

Filename
Date/Time Filename Number Suffix

DATE/TIME Filename
Date (Month DD, YYYY)

Sequence Number Date (DD Month, YYYY)

This submenu consists of 17 combinations of date and Metadata - Date (YYYYMMDD)
time data, as taken from the image’s metadata. There Dete DoNIGr S
] . o Date (YYMMDD)
are prebuilt date and time combinations (20220104, for Date (DDMMYY)
example, for a year-month-date token) in the list, or your et
) o Date (YYYY-MM-DD)
can build your own combinations out of the subtokens Year (YY)
listed in this menu. Month (Month)
Month (Mon)
Month (MM
Year data can be presented in either 4- or 2-digit D:yn(D[()) )
numbers, and Month data can be presented in month :me EEE;‘WSS}
ime

number, full name, or 3-letter abbreviations.

Time (mm)
Time (ss)
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SEQUENCE NUMBER

The Sequence Number tokens come into play when

Filename
exporting, importing or renaming a group of image files. Date/Time
There are essentially two tokens here, Sequence and Total, Ml Sequence (1)

. . . R R . Metadata Sequence (01)
with options for padding zeros into each item. Sequence will Sequence (001)
take the group of images being worked on and, starting with Sequence (0001)

. . . . . . Sequence (00001)
the first item in the selection, will start at 1 and increment Total (1)
by one as each image is processed. The Total token will Total (01)
always be a single number—the number of items in the group I":a: ggga)
. ota
being processed. Total (00001)

The combination of Sequence and Total tokens lets you
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu. e
All of the items create the chosen token based on the Datclime

. . Sequence Number
embedded metadata for each image being renamed, Camera
imported or exported. The specific text pulled from the :‘F;B‘T‘g‘_%son'-taaif's
Camera and IPTC tokens will be visible in the Metadata IPTC-Content

pane’s EXIF (for camera-specific data) and IPTC tabs. ikl

NOTE: Resize Al has no provision to add metadata to an image; the tokens
referenced here use any embedded metadata found in the image. If there
is no information in the specified Metadata token, it will be ignored during
processing.

Camera

The Camera submenu includes 21 items, all of which are

directly taken from an image’s EXIF data. Not all cameras : DAEDe o
. ) . Ratings Labels Exposure
capture all of the items listed, but most of them save essential IPTC-Contact ; Focal Length

items like exposure information, focal length and more. IPTC-Content Exposure Bias
IPTC-Image > Shutter Speed

Aperture

ISO

Flash

Exposure Program
Metering Mode
White Balance
Focus Distance
Make

Model

Serial Number
Author

Lens

GPS

Altitude
Direction

User Comment
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Ratings and Labels

Camera

The three tokens in the Ratings and Labels submenu pull
information from any rating, label and like information associated IPTC-Contact

with the image. IPTC-Content
IPTC-Image

The Rating token will add the number of stars an image is rated,
while the Label token will add any color label information (red,
yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers
much more detailed metadata information than EXIF. It historically has been used by journalists and stock
photographers to catalog and tag photos, as well as add copyright information, captions, and other data.
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact,
Content, and Image.

Camera
Ratings Labels

Camera Camera
Ratings Labels Ratings Labels
IPTC-Contact IPTC-Contact
Keywords IPTC-Content
IPTC-Image Headline Intellectual Genre
Subject Code Scene Code
Description Sublocation
Description Writer City
State/Province
Country
Title
Job Identifier
Instructions
Creditline
Source
Copyright
Usage Terms
Copyright URL

> Creator
IPTC-Content > Job Title
IPTC-Image Address
City
State/Province
Postal Code

Country
Phone
Email
Website

Using IPTC information makes the most sense when you have a strict method for importing and
categorizing image data during import (or shortly thereafter).
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Printing

ON1 Resize Al 2022 has a flexible print engine that can print photos at any size. You can print photos
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating
images. You can print from any module, even when using Resize as a plug-in.

Printer

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the
Print command from the File menu. It has the following components:

A.
B.

I o m m

Preview: Displays the photo or photos being printed.

View Selector: Lets you view the photos being printed individually, in facing-page view, or in
grid view. The icon on the far right turns soft proofing on and off.

. Filmstrip: Shows all of the photos that have been selected for printing, with check marks to

turn printing on or off. (The Filmstrip is not visible when a single image has been selected for
printing.)

Printer pane: Contains options for output—printer or PDF—as well as printer, page setup,
page size, number of copies, resolution, and printer profile and rendering intent.

Print Area pane: Contains options for fitting and selecting the print image size.

. Watermark pane: For adding a watermark to printed photos.

. Sharpening: Options for sharpening during the print process.

Print/Cancel: Print One (current image), Print All, or Cancel.

. Page view: Displays the number of pages being printed, and lets you move from page to page.
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The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a

specific printing-related task.
PRINTER PANE

The Printer pane is where you set the printer-specific features
for your output. It has two modes, which are chosen by clicking
on the icon at the top of the pane: Print, which lets you print to a

connected printer, and File, which will print the selection to a PDF.

When choosing to output to a printer, you'll set the specifics of
your printer, the paper size you wish to print to, the resolution,
orientation, and the number of copies. When choosing resolution,
make sure that you are printing at the printer’s optimal resolution.
Most photo printers, for example, work best with a file that has
between 240 and 360 ppi. (Resize will use its internal resampling
engine to ensure that your photo is at the print resolution you
choose.)

Printer

Mode:
Print File

Printer EPSON SC-P600 Series

Page Size US Letter

Orientation Copies 1

Resolution 300 v PPl v

Color:

Profile SC-P600 Series Hot Press Natural MK v2

Intent Perceptual

The Printer pane sets printer-specific options for
the current print job. You can also choose to render
the print job to a PDF file.

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile

for the paper type you are printing to.

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut)
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors

out of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to
play with the intent settings, but Perceptual is usually the best place to start. (You can use Resize Al's Soft
Proofing feature to look at out-of-gamut colors in your photos. See “Soft Proofing in Resize” on page 27

for more.)

NOTE: Resize Al's Print feature will work with borderless printing options as
well. Be sure to choose your printer’s borderless options in the Page Setup
window. Different printers will have specific borderless settings, so check the
printer’'s manual to see how to turn borderless printing on, and how to achieve

the proper sizing.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This
can be helpful if you are submitting prints to an online service or to print remotely. To use this option, click
on the File icon at the top of the pane. Resize will ask you for a filename and a location to save the file.
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you
choose Print, Resize will create a PDF of the photo (or photos) and save it with the name and destination

you specified earlier.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the Print Area
print, and how you wish your photos to be printed. You can also i .
choose whether to print photos individually, package-style, or to o p

create a contact sheet for evaluative purposes. E H

5x7

The top of the pane includes preset styles for either fitting the
current photo inside the print size, or filling the entire print size;
Mode:

options for printing at common print sizes, including 8x10, 5x7, single
Size 5x7

v Custom

4x6; and options for printing to a contact sheet. You can also

create custom print sizes via the Custom section at the bottom N’ — S
of the pane; just set the width and height of the print size, and One Photo per Page
whether you wish to fit the image to the print size, or to fill the Fitting. Fill

The Print Area pane is for setting the actual print

frame with it. If you would like to save this print size as a style, size of the photo or photos you are printing.

click on the More pop-up at the top of the pane, and choose Save
as New Style from the menu. You'll then be able to recall that style from the More pop-up whenever you
print.

If you are printing multiple photos, Resize will attempt to put as many photos at your chosen print size
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the
bottom of the Print Area pane.

Page size vs. print size

It's worth understanding the distinction between the page size and the print size. In some cases, the two
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which
means that there could be some extra white space around the final print. Fill will resize the photo to fill the
dimensions of the chosen print size, centering the image.

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you'll set the
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each
photo in the Print Area pane.
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WATERMARK PANE

The Watermark pane adds a graphic overlay to the printed image, W
and is most often used for your logo, signature or copyright.
Watermarks generally need a transparent background, so make
sure your watermark file is a PNG or PSD.

Style logo 2019

The module has the following options:

e Choose: Click the Choose button to select the file you
wish to use as your watermark. Once you've added a
watermark file, it will be saved to the Logo File pop-up.

e Size: This slider controls the size of the watermark file.

e Inset: This will determine the percentage in which the
file is inset from the edge, based on the Position (see
below).

Logo File CDP logo.png Choose...
e Opacity: This sets the opacity of the watermark. size 29

Inset 5

e Position: This grid sets the location of the watermark.

Opacity ————eooo 98
Click on the square of the location you desire. Position

When working with watermarks, make sure your watermark file
is sufficiently large for your usage. For example, if you want it to
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise,
it could appear pixelated on the print.

NOTE: Graphic watermarks imported via the Extras Manager (see page 10)

will appear in the Logo File pop-up menu. In addition, any watermarks imported
via the Choose button in the Watermark pane will be accessible in the Extras
Manager and in the Export window’s Watermark pane.

SHARPENING PANE

In most cases, and depending upon the media type you print Sharpening

to—glossy papers often benefit from additional sharpening, for Type  Print Glossy

example—you'll need to add an additional sharpening step when ‘F‘i’::‘;‘u"sm‘a””"de’

printing. This is an additional level of sharpening beyond anything High Pass Sharpen
Midtone Sharpen

you might have applied in Resize. Portransharppen
Print

The Sharpening pane lets you select a type of sharpening that will T T—

be applied to your photos during the printing process. The pop-up Print Glossy Portrai

Print High

menu has a set of options for general sharpening, including ones
for a standard print, glossy papers, details, high-pass sharpening,
and many more. Depending upon the image, you might need

to play with the settings here; performing test prints on small
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Use the Sharpening pane to add additional
sharpening to your printed image.
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BASIC PRINTING WITH RESIZE

Printing is available while you have an image open in ON1 Resize Al 2022 (or images, when using the
standalone version of Resize Al in batch mode). Clicking the Print icon will open the Print window with
the current image. There, you can set any of the options in the four panes on the right, and click the Print
button to output your photo.

If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for
the media type you are using, click the soft proofing icon underneath the preview area.

PRINTING MULTIPLE PHOTOS

When working with Resize Al's standalone batch mode (see page 27), you can print from the group of
photos—as a package or contact sheet—by clicking the Print icon. The selected photos will be displayed in
the filmstrip at the bottom of the Print window, and the preview area will display the current page (at the
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from
page to page via the Page View buttons under the preview. To see more pages, click on the Facing Pages or
Show All Pages icons at the bottom left of the window.

Print
Printer
Mode:
print  File
Printer
Page Size
Orientation
Resolution 300 v PPl v
Color
Pro ries Ho atural MK v2

Intent Perceptua

Print Area

I

& Height 5
toFit
oto per Page
Fitting_ Fill
Watermark
Sharpening

Type  Print Glossy

Pagelof12 { > Cancel | Print One Print All

(V] V]

[ ——

saturday wash.dng _MG_0565.CR2 bulb.CR2 _MG_6880.CR2 macaroons-..t-Editpsd  hiking-with-..dit-Editpsd  three-rings..-door-1.psd prairie.psd
The Print feature gives you extensive optios for printing multiple pages package style. Here, we have selected 24 photos to
print at 5x7 inches on a letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the

preview window, you can see all of the photos to be printed. Clicking Print One will print the currently selected page; clicking
Print All will print the collection.
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If you decide that you don’t want to print a photo, unclick the checkmark for that photo in the filmstrip. To
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page,
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

PRINTING CONTACT SHEETS

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the
Printer pane, and click on the Contact icon in the Print Area pane.

Print

Printer

Mode:
Print

Page Size US Letter

Orientation

Resolution 300 v PPl v

SC-P600 Series Photo Paper Glossy

Intent Perceptual

Print Area

E B N

Fit Fill 8x10

Eom o5

Custom More

v Custom
]
Mode: \!

Columns

Captions

Filename
Watermark
Sharpening

‘unset, waldo ke 630 original ARW IMG_7834-2 Editpsd

Cancel Print One Print All

o o o o [ )
TR " - =Y

haystacks-...24-003.ARW |union-coun...1-0079.ARW| palouse-20..8-0340.ARW valley-of-fire-190321.psd _7R33405.ARW death-vall..9-1097.NEF  death-valle...07-Edit|

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of
the Print Area pane:

e Columns: lets you set the number of columns across the page width. The smaller the number
of columns, the larger the individual cells.

e Captions: Currently, Resize lets you add the filename as a caption underneath the printed
photo. Click the button to the left of the label to turn this on or off. (We will be adding
additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when
you're ready to print, click the Print All button to print the contact sheets.

ONI1 Resize Al 2022 User Guide Part 3: Export, Printing and Sharing 48



Sharing Options (MacOS Only)

The MacOS version of ON1 Resize Al 2022 includes a number of photo-sharing options, including:

e Mail: Creates a new email message in Apple Mail with the shared
photo.

Mail

Messages

e AirDrop: Uses Apple’s AirDrop networking feature to share with
local MacOS or iOS devices. AirDrop

¢ Notes: Adds the shared photo to Apple’s Notes app. You can Notes
choose to create a new note, or add the photo to an existing note. Add to Photos

e Messages: Shares photo to Apple’s Messages app. Reminders
¢ Add to Photos: Adds the photo to Apple’s Photos app.

All of the sharing options perform the same operation: Resize exports a full-size JPEG of the selected photo
and shares it with the selected target from the list.
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RESIZE MENUS

ONT1 Resize Al 2022 (MacOS Only|

About ON1 Resize Al 2022: Opens the about box, displays
your version number. (This is in the Help menu on Windows)

Preferences (Mac): Opens the preferences dialog. (This item is
in the Edit menu on Windows.)

Quit ON1 Resize Al 2022: Quits ON1 Resize.

File Menu

Done: Saves the current image and returns to the startup
window or external source.

Cancel: Cancels any Resize operations and returns to the
startup window or external source.

Quick Export: Saves the current image in Photoshop, TIFF,
JPEG or PNG format

Export: Opens the Export window.

Export with Preset: Exports the current selection using a
preset from the hierarchical menu, bypassing the Export
window.

Export with Previous: Exports the current image with the last-
used Export setting.

Print: Opens up the print dialog box.

Manage Extras: Opens the Extras Manager window.

Edit Menu

Undo: Removes the last file operation.
Redo: Redoes the undo operation.

Cut: Cuts the currently selected item.
Copy: Copies the currently selected item.
Paste: Pastes the items in the clipboard.

Keyboard Shortcuts: Lets you add or modify the hotkeys for
many of Resize's commands.

Preferences (Windows): Opens the Preferences dialog.

ON1 Resize Al 2022

About ON1 Resize Al 2022
Preferences...
Services

Hide ON1 Resize Al 2022
Hide Others
Show All

Quit ON1 Resize Al 2022

File

Done
Cancel

Quick Export...
Export...
Export with Preset

Export with Previous
Print...

Manage Extras...

Edit

Undo

Keyboard Shortcuts...
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Settings Menu

Reset all Settings: Resets any settings made in Resize (current
image only).

Copy Settings: Copies all of the Resize Al settings applied to a
photo. (Copy is kept as long as Resize remains open.)

Paste Settings: Pastes the copied settings to the current
photo. (Kept as long as Resize remains open.)

Paste Settings from Previous Edit: Applies any Resize Al
adjustments made to the previous photo to the currently
selected photo. (Only applicable when using Resize Al in batch-
processing mode.)

Sync All Settings: Applies all of the Resize settings from

the primarily selected image to the rest of the images in

a selection. (Only applicable when using Resize Al in batch-
processing mode.)

Save Settings as Preset: Saves a new preset.

Update Preset with Current Settings: If an image with a
preset applied has had some settings changed, this lets you
update the preset to reflect those new settings.

Rename Preset: Renames the current preset.
Delete Preset: Deletes the currently selected preset.
Export Preset: Exports the current preset as an .onresize file.

Import Preset: Imports ON1 Resize preset files.

View Menu

Zoom In: Zooms the preview window in one increment. This
will make the preview image larger.

Zoom Out: Zooms the preview window out one increment.
This will make the preview images smaller.

Fit to Screen: This sets the preview image so that the entire
image is on screen at once. Think of this as an overview of the
entire image. This is the setting you will use most of the time.

Actual Pixels: This sets the preview image so that it zooms to
actual pixels or 1:1 also called 100%. This setting allows you
to see every pixel in the image. This is useful when making

Settings
Reset All Settings

Copy Settings

Sync All Settings

Save Settings as Preset...

Update Preset with Current Settings...

Rename Preset...

Delete Preset

Export Preset...
Import Preset...

View

Zoom In
Zoom QOut
Fit To Screen

Actual Pixels
Show Clipping

Show Preview

Compare

precision adjustments. Preview Background Color >
e Show Cll.pplng: Shosz the'cllpplng overlafy view, displaying the Enable Soft Proofing
pure white or black pixels in the current image. .
Gamut warning
e Show Preview: Toggle to enable or disable the preview. Profiles >
e Compare: Displays an adjustable split-screen view, with the Intent >
Before view on the left side of the preview area. v Simulate Paper and Ink
e Preview Background Color: Lets you set the background color
options for the Preview window.
¢ Enable Soft Proofing: Turns on soft proofing.
e Gamut warning: Displays colors that the printer can't
reproduce with a red overlay.
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Profiles: Displays a list of installed printer and display profiles;
selecting a profile will apply soft proofing for that profile.

Intent: Lets you switch between perceptual or relative
rendering intent for the current image.

Simulate Paper and Ink: Sets the white point and black point
of the display to account for that of the chosen profile.

Window

Help

Minimize: Minimizes your screen.
Zoom: Zooms your window to full-size (doesn’t hide menus).
Full Screen: Toggles full-screen mode (hides menu bar).

Navigator/Loupe/Histogram: Hides or shows the Navigator,
Loupe, Histogram (Levels) and Info pane.

Document Size: Opens or closes the Photo Size pane.
Settings: Opens/closes the settings pane.

Sharpening: Opens or closes the Sharpening pane.

Film Grain: Opens or closes the Film Grain pane.

Tiling: Opens or closes the Tiling pane.

Gallery Wrap: Opens or closes the Gallery Wrap pane.
Solo Mode: Keeps only one control pane open at a time.
Show Browser Panel: Hides/shows the left Browser panel.
Show Control Panel: Hides/shows the right Control panel.
Hide Panels: Hides or shows all Panels.

Document Name: Shows the name of the current image.

Search: Searches the menu options (MacOS only).

Learning Hub: Opens the Learning Hub window inside Resize.

ONZ1 Resize Al 2022 Online Help: Opens ON1.com support
page in your default web browser.

Video Tutorials: Opens ON1.com product training page in
your default web browser.

Check for Updates: Checks with the ON1 update server to
see if you are running the current version.

Sign-In/Sign-Out: Uses your ON1 account login information
to authenticate your copy of ON1 Resize Al 2022.

Provide Feedback: Opens the default web browser and goes
to the feedback page of the ON1 website.

About ON1 Resize: Opens the About box.

Help Improve ON1 Products: Opens the Improve ON1
Products dialog.

Show ONL1 Log: Diagnostic tool that can help ON1 support
when you're having issues with ON1 Resize Al 2022.

Window
Minimize
Zoom
Full Screen

Navigator
Document Size
Settings
Sharpening
Film Grain
Tiling

Gallery Wrap
Solo Mode

Show Browser Panel

v Show Control Panel

Hide Panels

DeathValley_20220304_7043_rsz.psd @ 20.4% 16-bit

Help

Learning Hub...
ON1 Resize Al 2022 Online Help...

Video Tutorials

Check for Updates
Sign-Out...

Provide Feedback...

Help Improve ON1 Products...
Show ON1 Log
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PREFERENCES

ON1 Resize Al 2022 has a number of system-wide settings that you can set via the Preferences window. To
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences
from the ON1 Resize Al 2022 menu (MacQOS) or the Edit menu in Windows.

The Preferences window has four tabs: General, Files, Plug-Ins, and System. The settings in each tab are
described below.

GENERAL SETTINGS
The General settings tab adjusts basic settings "o Preferences N
for the Resize workspace, including background Fles | Pluo-ine | System
color, scrolling controls and more. Scrolling Controls  None

Preview Background Color = Custom...

. Accent Color HE B H
Scrolling Controls -

(]
Lets you select how the mouse scroll wheel or Application Language  Auto
scrolling gesture works. The options are:  Check for Update on Launch
¢ None: Default. [ cancel (D

e Preview Zoom: Adjusts the zoom of the preview window. Scrolling up increases the zoom, scrolling
down decreases the zoom.

e Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the panning is
comfortable, not too fast or slow or jerky.

e Brush Size: Not applicable in Resize Al.
Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is

options for black, white, light gray, dark gray and custom. The custom option has a color picker where you
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Resize interface.

Application Language

Lets you change the display language for ON1 Resize Al 2022. Auto will use your system’s default language
(if available).

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start
Resize Al; if an update is available it will prompt you to download or skip.
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FILES

The Files tab has two options: ° Preferences
General Plug-ins | System

Default Processing

Ap p |y Le ns CO r reCTIO N TO RaW F| | es Apply Lens Correction Automatically to Raw Photos

Disable Base Corrections on Raw Photos

With this option on, the lens correction profile
will be applied automatically on any raw photo
when you preview it in Resize Al.

Cancel

Disable Base Corrections on Raw Files

With this option on, Resize Al will turn off the basic file correction settings applied to all raw images
can be helpful for scientific/technical photography, time-lapse, and other specialized applications.

PLUG-INS

The Plug-Ins tab is specific to using Resize as a L Preferences
plug-in for Photoshop or Lightroom, and sets up eneral | Fies (ETERIEN system
conditions when opening files from these apps.

General
Leave "ON1 Resize Al 2022" Open when Done

Photoshop

. This

G enera | Apply Results to  Copy of the Current Layer
Start with the Last Used Settings

When checked, the “Leave ON1 Resize Al 2022 Lightroom
Open” option will keep the app open after File Type  PSD (Supports Layers, Defaul)
processing an image via an external editor. Color Space _Adobe RGB 1998

Bit Depth  16-bit

Resolution 300| pixels/inch
Photosho

p Stack with Original
. . . Use Original for Single PSDs
Since Resize works on the complete composite € Ask Every Time
|mage (with layers), the Photoshop option is not — -
applicable. . 4
ONI1 Resize Al 2022 User Guide Part 5: Reference 55



Lightroom

This lets you choose the specific options for files opened via the Plug-In Extras menu in Lightroom:

e File Type: The file type drop-down menu determines what type of file will be created. The default is
PSD, which maintains layers. You can also select JPG or TIFF if you prefer those formats and are not
concerned about maintaining layers. The last option is same as source, which maintains the file type of
the original file, except for Lightroom raw files, which are saved as PSDs.

e Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

e Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

e Resolution: The resolution drop-down menu determines the resolution of the file.

e Stack with Original: When enabled, the new image is stacked with the original image.

e Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly,
rather than having a copy made.

o Ask Every Time: When checked, Lightroom will present these export copy options whenever you chose
an item from the Plug-In Extras submenu. Turning this option off will bypass the file-export window
inside Lightroom, using the options set here.

SYSTEM

r 3
The System tab displays performance- ® | Preflerences
e 4. . | il lug-i S
related characteristics of Resize Al 2022. —— S S
Memory Usage System Usage: 80 %
¢ System Usage: Specifies the VRAMUsage: 80 .

amount of RAM that is used by the
application. The maximum (default
Va|ue) is 80%. (Default Location) Move... Reset

Scratch Folder Location

o VRAM Usage: Specifies the amount
of video memory (VRAM) that is used ESiforance
by the application. The maximum Video Card Strength == Fast Panning

A ) Fast Preview
(default) is 80%. Low High 9 GpU Render

Scratch Folder Location . cancel (D

This setting lets you move or reset your memory cache, which helps speed editing operations while you're
running Resize. This is helpful if your system drive has limited space and wish to use a faster external drive
as a cache. This cache information is purged each time you quit the application.

Performance

The Performance section is designed to help you optimize Resize for your specific setup. The adjustments
you can make are as follows:

¢ Video Card Strength helps improve the performance of image previews in Resize. If you have a high-
end video card try turning it up for faster preview updating.

e Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve
performance of panning.
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o Fast Preview reduces the preview quality (makes it less sharp) while painting or making other
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

¢ GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and

caching. This can greatly improve performance. It is on by default for systems that support it. It may be
disabled on lower-end GPUs.
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